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MB106 : Computer Practical - LAB 

1. MS-EXCEL 

Unit – I: Introductory concepts of MS-EXCEL spreadsheet: 

Creating, Naming Saving, Editing and Printing of Worksheets. Data Entry - Manual and  

Automatic Formatting cells and Cell referencing. Creating and using formulas and Functions  

Use of Copy, Move and Paste Options. 

 

Unit II: Data And Graphical Options: 

Filling a Series, Sorting data, querying of data. Working with graphs and charts.  

 

 Unit III: Advanced Options of MS-EXCEL:  

a) Statistical tools – use statistical functions such as average, Standard  

Deviation, ANOVA, etc. b) Financial Tools – use of Financial Functions such as NPV, IRR etc.  

c) Date Functions d) Building Simple Macros. 

 

2. MS-ACCESS 

 Unit IV – Introduction to MS-ACCESS: 

Creating a database and tables by different methods- Entering and Editing data- Sorting,  

Filtering and Displaying data. Creating & querying using forms. Creating & printing reports  

and labels. 

 

 Unit V: Transfer of data between Excel & Access. 

 

Suggested Books: 

1. David Whigham, “Business Data Analysis Using Excel”, Oxford University Press, Indian  

Edition. 

2. Paul Cornell, “Accessing & Analyzing DATA with MS-EXCEL”. 

3. R & D, “IT Tools and Applications”, Macmillan India Ltd. 

4. Sanjay Saxena, “A First Course in Computers – Based on Windows Office XP”, Second  

Edition – Vikas Publishing House. 

5. P. Sudharsan & J. Jeyabalan, “Computers Systems & Applications”, Jaico Student  

Edition- Jaico Publishing House. 

6. D.P. Apte, “statistical Tools for Managers – using MS Excel”, 2009, Excel Books. 
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EXCEL 

 

INTRODUCTION 

 

 Microsoft Excel is the most widespread program for creating spreadsheets on the 

market today.  

 Spreadsheets allow you to organize information in rows and tables (which create cells), 

with the added bonus of automatic mathematics.  

 Spreadsheets have been used for many, many years in business to keep track of 

expenses and other calculations.  

 Excel will keep track of numbers you place in cells, and if you define cells to refer to 

each other, any changes made in one cell will be reflected in these referring cells. It 

sounds a bit complicated, but Excel makes it all a breeze. 

 

1. Microsoft Excel comes in a software Suite called Microsoft Office. MS Office contains 5 most 

popular and powerful windows applications: MS Word, MS Excel, MS Access, MS 

PowerPoint, and Outlook. 

 

a. Access is a relational database application 

b. Word is a word processor 

c. Excel is an electronic spreadsheet 

d. PowerPoint is presentation application 

e. Outlook Mail is electronic communication software 

 

2. Microsoft Office permits data in one of the applications to be copied, inserted or imported 

to any of the other applications in the package. 

3. Electronic spreadsheet stores information in the memory of computer, performs data 

manipulation and display result quickly. 

4. Spreadsheet can be saved, moved or printed.  

5. It serves the needs of a wide range of computer users. Spreadsheet applications include 

preparation of reports, payrolls, bills, income statements, budgets, load analysis, 

investment analysis, inventory control, and production analysis.  

6. There are many spreadsheet packages, and of them Microsoft Excel is the most popular 

one. 

 

Advantages of Spreadsheet 

1. Calculations can be done easily and quickly. 

2. It produces accurate results. 

3. Data in a worksheet can be displayed and manipulated. 

4. Data can be converted into graph. 

5. The entire worksheet or part of it can be printed. 

6. Facilitates carrying out “What-If” analysis. 

7. The data in a worksheet can be transferred to other programs easily. 
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Spreadsheet: 

A spreadsheet is a table of values arranged in rows and columns. Each value can have a 

predefined relationship to the other values. If you change one value, therefore, you may need 

to change other values as well. Spreadsheet applications (sometimes referred to simply as 

spreadsheets) are computer programs that let you create and manipulate spreadsheets 

electronically. In a spreadsheet application, each value sits in a cell. You can define what type of 

data is in each cell and how different cells depend on one another. The relationships between 

cells are called formulas, and the names of the cells are called labels. 

 

Once you have defined the cells and the formulas for linking them together, you can enter your 

data. You can then modify selected values to see how all the other values change accordingly. 

This enables you to study various what-if scenarios.  

 

There are a number of spreadsheet applications on the market, Lotus 1-2-3 and Excel being 

among the most famous. The more powerful spreadsheet applications support graphics 

features that enable you to produce charts and graphs from the data.  

 

Most spreadsheet applications are multidimensional, meaning that you can link one 

spreadsheet to another. A three-dimensional spreadsheet, for example, is like a stack of 

spreadsheets all connected by formulas. A change made in one spreadsheet automatically 

affects other spreadsheets. 

 

Features of Spreadsheet 

 

Excel 2003 is part of the Microsoft Office 2003 System. This latest release of Excel can be 

summed up in one word: DISAPPOINTING. Of all the Office 2003 components, it seems that 

enhancing Excel received the lowest priority.  

 

 

 

 

The new Excel features are:  

 

 The ability to import and (possibly) export XML data, and map the elements to cells in a 

worksheet. But this feature is not available in all editions of Excel 2003 (see below)  

 A new "designated" List feature that identifies a worksheet list by outlining it with a blue 

border.  

 Minor AutoFilter enhancements  

 The ability to synchronize worksheet scrolling to make it easier to compare two sheets  

 Fixes for some of the statistical functions.  

 Integration with Microsoft SharePoint Services 
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 Savvy developers will be able to create "Smart Documents" that utilize Smart Tags. This 

seems very complicated, and I haven't even bothered to explore it. 

 

Cell: 

In spreadsheet applications, a cell is a box in which you can enter a single piece of data. The 

data is usually text, a numeric value, or a formula. The entire spreadsheet is composed of rows 

and columns of cells. A spreadsheet cell is analogous to a field in database management 

systems.  

 

Individual cells are usually identified by a column letter and a row number. For example, D12 

specifies the cell in column D and row 12. In spreadsheet applications, a formula is an 

expression that defines how one cell relates to other cells. For example, you might define cell 

C5 (column C, row 5) with the formula =A4*D7 which means to multiply the value in cell A4 by 

the value in cell D7. 

 

Label: 

In spreadsheet programs, a label is any descriptive text placed in a cell. 

 

Workbook: 

A workbook is the file in which you work and store your data. Because each workbook can 

contain many sheets, you can organize various kinds of related information in a single file. You 

use worksheets to list and analyze data. You can enter and edit data on several worksheets 

simultaneously and perform calculations based on data from multiple worksheets. When you 

create a chart, you can place the chart on the worksheet with its related data or on a separate 

chart sheet. The names of the sheets appear on tabs at the bottom of the workbook window. 

To move from sheet to sheet, click the sheet tabs. The name of the active sheet is bold.  
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OPENING EXCEL 

 

Start >> Programs >> Microsoft Office >> Microsoft Office Excel 2003 

 

 
 

Microsoft Excel will automatically open with a blank spreadsheet spanning many columns and 

rows. You will notice a number of toolbars with many more options included. 

 

STANDARD TOOLBAR 

 

 
 

1.  New: 

Create a new, blank spreadsheet 

2.  Open: 

Open a previously saved spreadsheet 

3.  Save: 

Save your current spreadsheet 

5.  Print: 

Prints the current document 

6.  Print Preview: 

Preview the potential print of the current document. 

7.  Research: 

Microsoft has enabled Information Rights Management (IRM) within the new version 

of Excel, which can help protect sensitive documents from being copied or forwarded. 

Click this for more information and options. 
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8.  Copy: 

Copies the current selection to the clipboard, which can then be pasted elsewhere in 

the document 

9.  Paste: 

Takes the current clipboard contents and inserts them. 

10. Undo: 

Undoes the last action in the document, reverting “back” a step in time 

11. Insert Hyperlink: 

Inserts a hyperlink to an Internet location 

12. AutoSum: 

A drop-down menu of available mathematical operations to perform 

13. Sort Ascending: 

Sorts the current selection in ascending order 

14. Chart Wizard: 

Opens the “Chart Wizard,” which will walk you through the creation of a chart/diagram 

using the currently selected information 

15. Microsoft Excel Help: 

Brings up the Excel Help window, which will allow you to type in a key-word for more 

information, or click anything on screen to directly bring up further information on that 

subject 

16. More Options: 

There are a variety of extra options you can call or add to the toolbar, such as 

Spell Check, Sort Descending, Cut, Redo, etc.  By clicking the triangle, you can access 

these options; at the same time, you can drag this toolbar outwards more to make 

more available space for these options directly on the toolbar. 

 

 

FORMATTING TOOLBAR 

 

 
 

1.  Font: 

Change the font of the selected cell(s) 

2.  Size: 

Change the font size of the selection 

3.  Bold: 

Put the selection in bold face 

4.  Italics: 

Italicize the selection 

 

5.  Underline: 

Underline the selection 
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6.  Align Left: 

Align the current selection to the left 

7.  Center: 

Align the current selection to the center 

8.  Align Right: 

Align the current selection to the right 

9.  Merge & Center: 

Combine two selected cells into one new cell that spans the width of both and center 

the contents of this new cell 

10. Currency Style: 

Change the style in which currency is displayed 

11. Percent Style: 

Change the style in which percents are displayed 

12. Decrease Indent: 

Decrease the indent of a cell by approximately one character 

13. Border: 

Add or alter the style of borders to format a cell with 

14. Fill Color: 

Select a color to fill the background of a cell with 

15. Font Color: 

Select a color to apply to a selection of text 

 

You now have a basic understanding of the toolbars, but still have a huge window of cells in 

front of you. What can you do with them? Cells can contain text, numbers, or formulas (don't 

worry about formulas quite yet). To refer to a particular cell, you call it by its column letter, and 

then by its row letter. For example, the cell in the uppermost left corner would be "A1." The 

current cell(s) will always be listed in the "Name Box," which appears on the left below the 

toolbars. 

 

 
 

NAVIGATING THE SPREADSHEET 

 

You can use the "Up," "Down," "Left," "Right," to move (one cell at a time) throughout the 

spreadsheet. You can also simply click the cursor into a cell). The "tab" button will move one 

cell to the right. The "Enter" button will confirm the entered information and move one cell 

down. 

 

If you enter text or numbers that span further than the column allows, simply place your cursor 

on the line dividing two columns next to their respective letters, and drag to the right or left 

until the desired width is achieved. You can also double-click this dividing line to have Excel 
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automatically choose the best width. 

 

 
 

A SIMPLE SPREADSHEET 

 

 
 

This is what a basic spreadsheet may look like, keeping track of the grades for five students. As 

you'll notice, numbers automatically align to the right, while text automatically aligns to the 

left. Room has been allowed at the top and the left for column and row headings, which have 

been placed in bold. 

 

SIMPLE FORMULAS 

 

 
 

"92.67" was not entered as the contents for cell "E2." The "formula bar" has the following 

entered into it: 

=(B2+C2+D2)/3 

 

 

 

 

By following the normal order of operations, the contents of the three cells in parenthesis (B2, 

C2, and D2) are all added to each other, and then divided by 3. This gives an average of the 

three grades, which is then shown in the cell "E2" (where the formula was entered). 



 

Al-Qurmoshi Institute of Business Management | Computer Practicals - LAB 8 

 

 

If you wanted to do the same for students 2 through 5, you would enter in similar formulas for 

each cell from "E3" to "E6" replacing the column and row numbers where appropriate. 

 

An easy method to replicate formulas is to select the cell which contains the original formula 

("E2" in this case), click the bottom right corner of the selection box, and drag down several 

rows (to "E6" in this example). The formula will be copied down in each cell, and will change 

itself to reflect each new row. 

 

 
 

INSERT ROWS & COLUMNS 

 

You may find that you need to insert a new, blank row where there isn't a blank row any more. 

To insert a new blank row, place your cursor directly below where you would like a new row. 

Select Insert >> Rows. To insert a new column, place the cursor in a cell directly to the right of 

where you would like the column. Select Insert >> Columns. 
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SORTING 

 

One of Excel’s powerful features is its ability to sort, while still retaining the relationships 

among information. For example, let’s take our student grade example from above. What if we 

wanted to sort the grades in descending order?  First, let’s select the information we want to 

sort. 

 

 
 

Now let’s select the “Sort” option from the “Data” menu. 

 

 
 

A new window will appear asking how you would like to sort the information. Let’s sort it by the 

average grade, which is in Column E; be sure to set by “Descending” order. If there were other 

criteria you wished to sort by as secondary measures, you could do so; let’s select “Then by” as 

“Grade 3” just for the practice of doing so (“Descending” order, as well). 
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Excel will sort your information with the specifications you entered. The results should look 

something like this: 

 

 
 

 

CELL FORMATTING: 

 

You may notice that, by default, Excel will leave as many decimal points as possible within the 

cell’s width restraints; as you increase the cell’s width, the number of decimal points increases. 

 

 
 

Select “Cells” from the “Format” menu. A new window will appear with a wide variety of ways 

in which to customize your spreadsheets. 
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For example, if we wanted to set the percentages fixed to only two decimal points, you can 

make this selection under the “Number” category within the “Number” tab. You can also set 

the formatting for things such as the date, time, currency, etc. 

 

The “Font” tab will also allow you to change the default font used on the spreadsheet. The 

other tabs provide even more ways to customize your spreadsheet and its appearance; 

experiment with the settings to see what works best for you. 

 

 

CHART WIZARD 

 

Excel allows you to create basic–to–intermediate charts based on information and data within 

your spreadsheets.  

 

EXCEL BASICS 

 

1. The Spreadsheet has integrated three components: worksheet, graphics & database into it. 

2. Excel’s basic file format is a workbook. Each workbook can hold many worksheets. 

3. Excel workbook contains three blank worksheets by default. 

4. An index tab at the bottom of the worksheet identifies each worksheet as sheet 1, sheet 2 

etc. 

5. Excel worksheet data, charts and graphs can be easily transferred to MS PowerPoint and MS 

word. 

 

WORKBOOK AND WORKSHEET  

 

1. Worksheets are made up of cells arrayed in columns and rows. 

2. The rows are identified by numbers 1,2… and the columns by letters like A,B…. 
3. Each cell has a unique address made up of the column and row labels like A1, B5 etc. 

4. Each worksheet contains 256 columns and 65536 rows. 

5. That is, a large amount of data can be stored in Spreadsheet as each worksheet has 

167,77,216 cells. 

6. A work book contains three worksheets by default.  

 

 

 

 

How can I increase the number of rows or columns in a worksheet?  

 

In Excel, every workbook has 255 columns and 65,526 rows. These values are fixed and cannot 

be changed. If you need more rows, you might want to consider using a database (such as 

Access) or another spreadsheet (Quattro Pro can handle a million rows) for data storage. In 

most cases, you probably don't need to work with all of your data at once. You'll usually need 
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only a subset of your data. You can use Excel's Data, Get External Data command to query the 

database and bring in only the records you need. 

 
CELL REFERENCING 

 

When you use a cell (or range) reference in a formula, you can use three types of references: 

 

Relative:  The row and column references can change when you copy the formula to another 

cell because the references are actually offsets from the current row and column. 

Absolute: The row and column references do not change when you copy the formula because 

the reference is to an actual cell address. 

Mixed:  Either the row or column reference is relative, and the other is absolute. 

 

 

EXCEL FORMULAE 

 

A Formula is a calculation performed to determine a value in a specific cell of your Excel 

worksheet. 

 

All formulas start with the equals (=) sign.  

 

Examples of Excel Formulas  

 

=A2 + A3 (addition) 

=A2 - A3 (subtraction)  

=A1 * A4 (multiplication) 

=A1 / A4 (division) 

 

 

 

 

Order of Operations 

 

Order Operator Description 

1 (  ) Parentheses 

2 ^ Exponents 

3 */ Multiplication/Division 

4 + - Addition/Subtraction 

For example: 

 

= 5 + 4 * 2 Answer: 13 

= (5 + 4) * 2 Answer: 18 
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EXCEL FUNCTIONS 

 

A Function is a predefined formula; one that already exists (e.g., sum, average, count, min, 

max) for you to use on your data. 

 

EXAMPLES OF EXCEL FUNCTIONS 

 

Functions are pre-defined formulas that perform special or advanced calculations. Each 

function requires a function name and at least one argument: 

=function-name (argument) 

 

Arguments, which appear in parentheses, can consist of numbers, cell references, ranges 

or text. Use commas when there is more than one argument in a function. 

 

 

THE ABSOLUTE VALUE 

 

The decimal numeric system counts from minus infinity (-∞) to infinity (+∞). This means 
that a number can be usually negative or positive, depending on its position from 0, which 

is considered as neutral. In some operations, the number considered will need to be only 

positive even if it is provided in a negative format. 

 

The absolute value of a number x is x if the number is (already) positive. If the number is 

negative, then its absolute value is its positive equivalent. For example, the absolute value 

of 12 is 12, while the absolute value of –12 is 12. 

 

To get the absolute value of a number, you can use one of the ABS() function. Its syntax is: 

ABS(number) 

 

EXAMPLES OF EXCEL FUNCTIONS 

 

Function Result Displayed Example 

AVERAGE The mean of the cells referred 

to in parentheses 

=AVERAGE(A3:A6) 

COUNT The number of numerical values 

in the cells referred to in 

parentheses 

=COUNT(A3:A6) 

COUNTA The number of non-empty cells 

among those referred to in 

parentheses 

=COUNTA(A3:A6) 

MAX The highest value among the =MAX(A3:A6) 
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cells referred to in 

parentheses 

MIN The lowest value among the cells 

listed in parentheses 

=MIN(A3:A6) 

SUM Total of all the numbers in a range =SUM(A3:A6) 

TODAY Today’s date =TODAY() 

 

FINANCIAL FUNCTIONS  

   

INTRODUCTION 

 

Microsoft Excel provides a series of functions destined to perform various types of financially 

related operations. These functions use common factors depending on the value that is being 

calculated. Many of these functions deal with investments or loan financing. 

 

THE DOUBLE DECLINING BALANCE 

The Double Declining Balance is a method used to calculate the depreciating value of an 

asset.  To get it, you can use the DDB function whose syntax is: 

 

DDB(cost, salvage, life, period, factor) 

 

The first argument, cost, represents the initial value of the item and it is required. The salvage 

argument is the estimated value of the asset when it will have lost all its productive value. This 

argument also is required. The cost and the salvage values must be given in their monetary 

values. The value of life is the length of the lifetime of the item; this could be the number of 

months for a car or the number of years for a house, for example. The period is a factor for 

which the depreciation is calculated. It must be in the same unit as the life argument. For the 

Double Declining Balance, this period argument is usually 2. 

 

THE STRAIGHT LINE DEPRECIATION 

 

Excel provides another method used to calculate the depreciation of an item. This time, the 

depreciation is considered on one period of the life of the item. The function used is SLN and its 

syntax is: 

 

SLN(cost, salvage, life); 

 

The cost argument is the original amount paid for an item (refrigerator, mechanics toolbox, 

high-volume printer, etc). The salvage, also called the scrap value, is the value that the item will 

have (or is having) at the end of Life. The life argument represents the period during which the 

asset is (or was) useful; it is usually measured in years. 
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DATE AND TIME FUNCTIONS 

 

TODAY Function 

The Today function is a volatile Date and Time function that returns the current date (updates 

when file is opened or the worksheet is recalculated). This function does not require any 

arguments, but you must still include the empty parentheses after the function name. 

 

Basic Concept/Example:  =TODAY() 

 

It is probably easier to type the TODAY function from scratch. If you do, make sure you include 

the open and closed parenthesis after the function name – no argument is needed for this 

function. 

 

NOW Function 

Returns the current date and time (updates when file is opened or the worksheet is 

recalculated). This function does not require any arguments, but you must still include the 

empty parentheses after the function name. 

 

Basic Concept/Example:  =NOW() 

 

How can I calculate the difference between two dates? 

 

Excel stores dates as serial numbers. The number 1 represents January 1, 1900, the number 2 

represents January 2, 1900, and so on. Formatting these numbers using a date format causes 

them to appear as actual dates. Therefore, if you have dates stored in two cells, you can simply 

create a formula that subtracts one from the other to get the number of intervening days. You'll 

want to make sure that the formula cell is formatted as a number, not a date.  

 

You might also find the DATEDIF function useful. This function, which was not documented 

prior to Excel 2000, returns the difference between two dates, expressed in years, months, or 

days. You might use the DATEDIF function to calculate how many months the payment on an 

invoice is overdue or to determine a person's age when you know their birth date. 

 

Excel's DATEDIF function takes three arguments. Its syntax is: 

=DATEDIF(start_date,end_date,units) 

 

In the syntax, start_date is a date or reference to a date, end_date is a date or reference to a 

date, and units is a one- or two-digit string (in double quotes) specifying the units for the 

difference between the two dates. Acceptable values for the units argument are shown below. 

 

 y returns the number of full years in the period.  

 m returns the number of full months in the period.  
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 d returns the number of full days in the period.  

 md returns the number of full days in excess of the last full month.  

 ym returns the number of full months in excess of the last full year.  

 yd returns the number of full days in excess of the last full year. 

 

For example, assume cells A1 and B1 contain dates. The formula below returns the number of 

full years between the dates (useful for calculating a person's age): 

=DATEDIF(A1,B1,"y") 

 

The formula below calculates the number of full months between the two dates: 

=DATEDIF(A1,B1,"m") 

 

LOGICAL FUNCTION 

 

1. IF 

2. Nested IF 

 

IF Function 

The IF function is a Logical function that is designed to return one value if a condition you 

specify evaluates to be TRUE and another value if it evaluates to be FALSE. In other words, the 

function can only give one of two possible answers. For example, if you exceed the sales quota, 

you get a bonus, if not, you get nothing; or as show in Figure 9, if the value in the cell E7 is 

greater than cell F7, multiply cell E7 by 10%, or display 0 (zero). 

 

Basic Concept:  =IF(logical_test, value_if_true, value_if_false) 

Example:  =IF(E7>F7,E7*0.1,0) 

 

Nested IF Function 

A Nested function is simply a function within another function. The result returned from one 

function is used as the argument of another function. A nested formula can contain up to seven 

levels of arguments and do not need to be IF functions. 

 

Basic Concept:  =IF(logical_test,=IF(logical_test, value_if_true, value_if_false))  

Example: =IF(I9=1,H9*0.1,IF(I9=2,H9*0.08,H9*0.07)) 

 

STATISTICAL FUNCTIONS 

 

1. AVERAGE 

2. MEDIAN 

3. MODE 

4. MAX 

5. MIN 

6. COUNT 
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AVERAGE Function 

Another common calculation is Excel is the AVERAGE function (Figure 7, 1). The AVERAGE 

function is a Statistical function which returns the arithmetic mean of a list of values. In other 

words, it adds up the total value of all the cells selected and divides it by the number of cells 

selected. 

 

Basic Concept: =AVERAGE (number1, number2, number3,…)  
Example: =AVERAGE(B6:F6) 

 

 

 

MEDIAN Function 

Another type of statistical function is the MEDIAN function (Figure 7, 2). The MEDIAN function 

returns the middle of a distribution (half the scores are above the median and half are below 

the median) of all the numbers evaluated by the formula. 

 

Basic Concept: =MEDIAN (number1, number2, number3,...)  

Example: =MEDIAN(B6:F6) 

 

MODE Function 

A third type of statistical function is the MODE function (Figure 7, 3). The MODE function 

returns the most common or frequent value in a data set. 

 

It is possible that there is no match and Excel displays #N/A (Figure 7, 1). 

 

Basic Concept: =MODE (number1, number2, number3,...)  

Example: =MODE(B6:F6) 

 

COUNT Function 

A fourth type of statistical function is the COUNT function (Figure 7, 4). The COUNT function 

counts the total number of cells that contain numbers or data. 

 

Basic Concept: =COUNT (value1, value2,...)  

Example: =COUNT(B6:B17) 

 

MAX Function 

Another type of statistical function is the MAX function (Figure 7, 5). The MAX function returns 

the largest value of all the numbers evaluated by the formula. 

 

Basic Concept: =MAX (number1, number2, number3,…)  
Example: =MAX(B6:B17) 
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MIN Function 

Another type of statistical function is the MIN function (Figure 7, 6). The MIN function returns 

the smallest value of all the numbers evaluated by the formula. 

 

Basic Concept:  =MINnumber1, number2, number3,…)  
Example: =MIN(B6:B17) 

 

CHARTS 

 

Charts are used to analyze data graphically 

 

 

GOAL SEEK 

 

Excel's Goal Seek feature allows you to alter the data used in a formula in order to find out 

what the results will be. The different results can then be compared to find out which one best 

suits your requirements.  

 

Goal Seek is used when you know what answer you want, but don't know the exact figure to 

input for that answer. For example, you're quite certain that 8 multiplied by something equals 

56. You just not sure what that missing number is. Is it 8 multiplied by 6? Or Is it 8 multiplied by 

7? Goal Seek will tell you the answer.  

 

We'll test that example out right now. So start a new spreadsheet, and create one the same as 

in the image below: 

 
 

Before you can use Goal Seek, Excel needs certain things from you. First it needs some sort of 

formula to work with. In the image above we have the simple formula =B1 * B2. We've put this 

in cell B3. But the answer is wrong for us. We had a Goal of 56 (8 times something). We want to 

know which number you have to multiply 8 by in order to get the answer 56. We tried 8 times 

6, and that gave the answer of 48. So we have to try again. 

 

Instead of us puzzling the answer out, we can let Goal Seek handle it. So do the  
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PIVOT TABLE 

 

A pivot table is a program tool that allows you to reorganize and summarize selected columns 

and rows of data in a spreadsheet or database table to obtain a desired report. A pivot table 

doesn't actually change the spreadsheet or database itself. In database lingo, to pivot is to turn 

the data (see slice and dice) to view it from different perspectives. 

 

AUTOSUM 

 

A function in a spreadsheet program that inserts a formula in the selected cell that adds the 

numbers in the column above it. It sets the range of cells by looking for numeric data above the 

selected cell. 

 

Autosum allows you to automatically insert the SUM function into a cell. It will then also 

automatically select a group of cells to add if there are cells with numbers in them nearby. If 

you do it at the bottom of a column of numbers, it will automatically select the ones above to 

sum and if you put it at the end of a row of numbers, it will automatically select the numbers in 

that row to sum. You still have the option of choosing a different range of cells to sum. 

Autosum also gives you the option to do other common operations such as MAX, MIN, 

AVERAGE, COUNT and COUNTA instead of using SUM.  

 

 

The Autosum Function 

After selecting the cell to the right of Total Monthly and clicking the autosum icon (red arrow is 

pointing to it), the range from F3 to F9 is automatically determined by the program. 

 

AUTOFILTER 

 

http://whatis.techtarget.com/definition/0,289893,sid9_gci532933,00.html
http://whatis.techtarget.com/definition/0,289893,sid9_gci211895,00.html
http://whatis.techtarget.com/definition/0,289893,sid9_gci212997,00.html
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AutoFilter is an easy way to turn the values in Excel column into specific filters based on the cell 

contents. 

 

SORTING 

 

Sorting in Excel lets you easily reorder your data based on the type of sorting that you choose. 

This lesson will show you how to do a normal and reverse alphabetical sort, as well as 

descending numerical ordering. 

 

CONDITIONAL FORMATTING 

 

What is Conditional Formatting? 

 

Conditional formatting allows you to select one or more cells, and create rules for when and 

how those cells are formatted.  

You can control the cell font, fill color and border setting, based on the selected cell's contents, 

or based on the contents of another cell. 

If the rules (conditions) that you specified are met, then the formatting is applied.  

For example, you can set conditional formatting so that a cell turns blue or green, based on its 

value. 

 

MACROS IN EXCEL 

 

SUBTOTALS 

 

Excel accepts cell references in what are called absolute and relative ranges. Absolute ranges 

have a $ character before the column portion of the reference and/or the row portion of the 

reference. Relative ranges do not use the $ character.  The $ character indicates to Excel that it 

should not increment the column and/or row reference as you fill a range with a formula or as 

you copy a range. For example A1 is a relative range, while $A$1 is an absolute range. If you 

enter =A1 in a cell and then fill that cell down a column, the '1' in the reference will increment 

in each row. Thus, the formula in row 50 would be =A50. However, if you enter =$A$1 in a cell 

and fill down, the range reference will remain $A$1 -- it will not increment as you fill or copy 

down a column.  

 

There are three absolute styles:   

 

Reference Style Meaning 

$A$1 Both the column and row reference are fixed. Neither will be incremented or 

changed during a copy or fill operation. 

$A1 Only the column reference is fixed. It will not change during a fill or copy, but 

the row will change. 
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A$1 Only the row reference is fixed. It will not change during a fill or copy, but the 

column will change. 

 

 

ACCESS 

 
WHAT IS A DATABASE? 

 

A database is a collection of data which is organized in a manner that can be easily retrieved. They 

consist of fields, records, and files, much like a telephone book. A field is a single piece of information 

(your last name is one field); a record is one complete set of fields (your entry in the telephone book is a 

record); and a file is a collection of records (the entire telephone book). When you look at the phone 

book for someone's telephone number, you are the "search engine" for the telephone book database. 

The only difference is that the search engine included with database programs is probably a little faster 

than you are at retrieving information. 

 

Let us begin with the concept ‘database’ and its management. Database is a collection of information in 

a structured way. We can say that it is a collection of a group of facts. Your personal address book is a 

database of names you like to keep track of, such as personal friends and members of your family. 

 

WHAT IS A RELATIONAL DATABASE? 

 

A relational database is a single database spread across multiple tables. Think of a database as a file 

cabinet and each drawer of the file cabinet is a table. 

 

Example: All of the employee information is kept in the first 

drawer; all of the vendor information is kept in the second 

drawer; and all of the purchase orders are kept in the third 

drawer. To connect each of these drawers (which is what makes it 

"relational"), a set piece of data from one drawer has to be 

present in one of the other drawers. 

 

For instance, a purchase order will have a vendor name, address, 

& phone number on it, along with the items purchased, purchase 

price, and any discounts. If the vendor name is the "set" piece of 

data, it is entered in the purchase order table, but the address & 

phone number are retrieved from the vendor table instead of 

having to re-type that information each time it is needed in the 

purchase order table. 

 
TERMS 

 
 A database is a collection of related information. 

 An object is a competition in the database such as a table, query, form, or macro. 

 A table is a grouping of related data organized in fields (columns) and records (rows) on a 

datasheet. By using a common field in two tables, the data can be combined. Many tables can 
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be stored in a single database. 

 A field is a column on a datasheet and defines a data type for a set of values in a table. For a 

mailing list table might include fields for first name, last name, address, city, state, zip code, and 

telephone number. 

 A record in a row on a datasheet and is a set of values defined by fields. In a mailing list table, 

each record would contain the data for one person as specified by the intersecting fields. 

 Design View provides the tools for creating fields in a table. 

 Datasheet View allows you to update, edit, and delete in formation from a table. 

 
TABLES 

 

Tables are grids that store information in a database similar to the way an Excel worksheet stores 

information in a workbook. Access provides three ways to create a table for which there are icons in the 

Database Window. Double-click on the icons to create a table. 

 

 
The Database Window 

 

 Create table in Design view will allow you to create the fields of the table. This is the most common 

way of creating a table and is explained in detail below. 

 Create table using wizard will step you through the creation of a table. 

 Create table by entering data will give you a blank datasheet with unlabelled columns that looks 

much like an Excel worksheet. Enter data into the cells and click the Save button. You will be 

prompted to add a primary key field. After the table is saved, the empty cells of the datasheet are 

trimmed. The fields are given generic names such as "Field1", "Field2", etc. To rename them with 

more descriptive titles that reflect the content of the fields, select Format|Rename Column from 

the menu bar or highlight the column, right-click on it with the mouse, and select Rename Column 

from the shortcut menu. 

 

CREATE A TABLE IN DESIGN VIEW 
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Design View will allow you to define the fields in the table before adding any data to the datasheet. The 

window is divided into two parts: a top pane for entering the field name, data type, and an option 

description of the field, and a bottom pane for specifying field properties. 

 

 
 

 Field Name - This is the name of the field and should represent the contents of the field such as 

"Name", "Address", "Final Grade", etc. The name can not exceed 64 characters in length and 

may include spaces. 

 Data Type is the type of value that will be entered into the fields. 

 Text - The default type, text type allows any combination of letters and numbers up to a 

maximum of 255 characters per field record. 

 

o Memo - A text type that stores up to 64,000 characters. 

o Number - Any number can be stored. 

o Date/Time - A date, time, or combination of both. 
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 Currency - Monetary values that can be set up to automatically include a dollar sign ($) and 

correct decimal and comma positions. 

 AutoNumber – When a new record is created, Access will automatically assign a unique integer 

to the record in this field. From the General options, select Increment if the numbers should be 

assigned in order or random if any random number should be chosen. Since every record in a 

datasheet must include at least one field that distinguishes it from all others, this is a useful data 

type to use if the existing data will not produce such values. 

 Yes/No – Use this option for True/False, Yes/No, On/Off, or other values that must be only one 

of two. 

 OLE Object – An OLE (Object Linking and Embedding) object is a sound, picture, or other object 

such as a Word document or Excel spreadsheet that is created in another program. Use this data 

type to embed an OLE object or link to the object in the database. 

 Hyperlink – A hyperlink will link to an Internet or Intranet site, or another location in the 

database. The data consists of up to four parts each separated by the pound sign (#): 

DisplayText#Address#SubAddress#ScreenTip. The Address is the only required part of the string. 

Examples: 

 

Home Page #http://www.nizamcollege.ac.in# 

#c:\My Documents\database.mdb#MyTable 

 

 Description (optional) - Enter a brief description of what the contents of the field are. 

 Field Properties - Select any pertinent properties for the field from the bottom pane. 

 

Field Properties 

 

Properties for each field are set from the bottom pane of the Design View window. 

 

 Field Size is used to set the number of characters needed in a text or number field. 

 

The default field size for the text type is 50 characters. If the records in the field will only have two 

or three characters, you can change the size of the field to save disk space or prevent entry errors by 

limiting the number of characters allowed. Likewise, if the field will require more than 50 characters, 

enter a number up to 255. The field size is set in exact characters for Text type, but options are give 

for numbers: 

 

o Byte - Positive integers between 1 and 255 

o Integer - Positive and negative integers between -32,768 and 32,768 

o Long Integer (default) - Larger positive and negative integers between -2 billion and 2 

billion. 

o Single - Single-precision floating-point number 

o Double - Double-precision floating-point number 

o Decimal - Allows for Precision and Scale property control 

 

 Format confirms the data in the field to the same format when it is entered into the datasheet. For 

text and memo fields, this property has two parts that are separated by a semicolon. The first part 

of the property is used to apply to the field and the second applies to empty fields. 

 

http://www.raiunuversity.edu/


 

Al-Qurmoshi Institute of Business Management | Computer Practicals - LAB 25 

 

 

 

 

 

Text and Memo Format 

 

Text Format 

Format Datasheet Entry Display Explanation 

 

@@@-@@@@ 

 

1234567 

 

123-4567 

@ indicates a required 

character or space 

 

@@@-@@@& 

 

123456 

 

123-456 

& indicates an optional 

character or space 

 

< 

 

HELLO 

 

hello 

< converts characters to 

lowercase 

 

> 

 

hello 

 

HELLO 

> converts characters to 

uppercase 

@\! Hello Hello! \ adds characters to the end 

@;"No Data Entered" Hello Hello  

@;"No Data Entered" (blank) No Data Entered  

 

 Number format. Select one of the preset options from the drop down menu or construct a 

custom format using symbols explained below: 

 

Number Format 

Format Datasheet Entry Display Explanation 

###,##0.00 123456.78 123,456.78 0 is a placeholder that displays a digit or 0 if there is 

none. 

# is a placeholder that displays a digit or nothing if 

there is none. 

$###,##0.00 0 $0.00 

###.00% .123 12.3% % multiplies the number by 100 and added a 

percent sign 

 

 Currency format. This formatting consists of four parts separated by semicolons: format for 

positive numbers; format for negative numbers; format for zero values; format for Null values. 

Currency Format 

Format Explanation 

$##0.00;($##0.00)[Red];$0.00;"

none" 

Positive values will be normal currency format, negative 

numbers will be red in parentheses, zero is entered for zero 

values, and "none" will be written for Null values. 

 

 

 

 

 

mailto:@-
mailto:@&
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 Date format. In the table below, the value "1/1/01" is entered into the datasheet, and the 

following values are displayed as a result of the different assigned formats. 

 

Date Format 

Format Display Explanation 

dddd","mmmm d","yyyy Monday, January 1, 2001 dddd, mmmm, and yyyy print the full 

day name, month name, and year 

ddd","mmm ". " d", '"yy Mon, Jan. 1, '01 ddd, mmm, and yy print the first 

three day letters, first three month 

letters, and last two year digits 

"Today is " dddd Today is Monday  

h:n:s: AM/PM 12:00:00 AM "n" is used for minutes to avoid 

confusion with months 

 

 Yes/No fields are displayed as check boxes by default on the datasheet. To change the 

formatting of these fields, first click the Lookup tab and change the Display Control to a text box. 

Go back to the General tab choices to make formatting changes. The formatting is designated in 

three sections separated by semicolons. The first section does not contain anything but the 

semicolon must be included. The second section specifies formatting for Yes values and the 

third for No values. 

 

Yes/No Format 

Format Explanation 

;"Yes"[green];"No"[red] Prints "Yes" in green or "No" in red 

 

 Default Value - There may be cases where the value of a field will usually be the same for all 

records. In this case, a changeable default value can be set to prevent typing the same thing 

numerous times. Set the Default Value property. 

 

PRIMARY KEY 

 

Every record in a table must have a primary key that differentiates it from every other record in the 

table. In some cases, it is only necessary to designate an existing field as the primary key if you are 

certain that every record in the table will have a different value for that particular field. A social security 

number is an example of a record whose values will only appear once in a database table. 

 

Designate the primary key field by right-clicking on the record and selection Primary Key from the 

shortcut menu or select Edit|Primary Key from the menu bar. The primary key field will be noted with a 

key image to the left. To remove a primary key, repeat one of these steps. 
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If none of the existing fields in the table will produce unique values for every record, a separate field 

must be added. Access will prompt you to create this type of field at the beginning of the table the first 

time you save the table and a primary key field has not been assigned. The field is named "ID" and the 

data type is "autonumber". Since this extra field serves no purpose to you as the user, the autonumber 

type automatically updates whenever a record is added so there is no extra work on your part. You may 

also choose to hide this column in the datasheet as explained on a later page in this tutorial. 

 

Indexes 

 

Creating indexes allows Access to query and sort records faster. To set an indexed field, select a field 

that is commonly searched and change the Indexed property to Yes (Duplicates OK) if multiple entries 

of the same data value are allowed or Yes (No Duplicates) to prevent duplicates. 

 

Field Validation Rules 

 

Validation Rules specify requirements (change word) for the data entered in the worksheet. A 

customized message can be displayed to the user when data that violates the rule setting is entered. 

Click the expression builder ("...") button at the end of the Validation Rule box to write the validation 

rule. Examples of field validation rules include <> 0 to not allow zero values in the record, and ??? to 

only all data strings three characters in length. 

 

Input Masks 

 

An input mask controls the value of a record and sets it in a specific format. They are similar to the 

Format property, but instead display the format on the datasheet before the data is entered. For 

example, a telephone number field can formatted with an input mask to accept ten digits that are 

automatically formatted as "(555) 123-4567". The blank field would look like (  )   -  . An 

input mask to a field by following these steps: 

 

 In design view, place the cursor in the field that the input mask will be applied to. 

 Click in the white space following Input Mask under the General tab. 

 Click the "..." button to use the wizard or enter the mask, (@@@) @@@-@@@@, into the field 

provided. The following symbols can be used to create an input mask from scratch: 

 

Input Mask Symbols 

Symbol Explanation 

A Letter or digit 

0 A digit 0 through 9 without a + or - sign and with blanks displayed as zeros 

9 Same as 0 with blanks displayed as spaces 

# Same as 9 with +/- signs 

? Letter 

L Letter A through Z 

C or & Character or space 

< Convert letters to lower case 

> Convert letters to upper case 

mailto:@-
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RELATIONSHIPS 

 
To prevent the duplication of information in a database by repeating fields in more than one table, table 

relationships can be established to link fields of tables together. 

 

REPORTS 

 
Reports will organize and group the information in a table or query and provide a way to print the data 

in a database. 

 

QUERYING 
 

Queries select records from one or more tables in a database so they can be viewed, analyzed, and 

sorted on a common datasheet. The resulting collection of records, called a dynaset (short for dynamic 

subset), is saved as a database object and can therefore be easily used in the future. The query will be 

updated whenever the original tables are updated. Types of queries are select queries that extract data 

from tables based on specified values, find duplicate queries that display records with duplicate values 

for one or more of the specified fields, and find unmatched queries display records from one table that 

do not have corresponding values in a second table. 

 

FORMS 
 

Forms are used as an alternative way to enter data into a database table. 

 
WHAT IS A SUBFORM? 

 

A subform is a form that is placed in a parent form, called the main form. Subforms are particularly 

useful to display data from tables and queries that have one-to-many relationships.  

 

EXCEL vs ACCESS 

 

In both Access and Excel, you can: 

 

 Run powerful queries to sort and filter your data.  

 Run sophisticated calculations to derive the information you want.  

 Use Microsoft PivotTable® and Microsoft PivotChart® views to work with your data 

interactively.  

 Generate reports on your data and view them in multiple formats.  

 Use forms to add, change, delete, and navigate your data easily.  

 Create a Microsoft Word mail merge — for example, to mass-produce address labels.  

 Connect to external data and view, query, and edit it without having to import.  

 Create Web pages to display your data as read-only or to access it in an updatable format.  

 Import data from external databases (Access, Microsoft SQL Server™) and other file types 

(.txt or .htm).  
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 Both programs organize data in columns, also called fields, that store a particular kind of 

information, or data type. At the top of each column, the first cell is used to label the 

column. One difference in terminology is that what is called a row in Excel is called a record 

in Access. 

 As an example, you could create a personnel list. Your list might have five columns to 

organize employees' ID numbers, first names, last names, telephone numbers at work, and 

dates of hire. The cell row at the very top of each column would contain text labels to 

describe the data. 

 

Why the comparison? 

 

This is a fair question. After all, Excel is not a database management system. It is spreadsheet 

software, and it stores units of information in rows and columns of cells, called worksheets. The 

most common task performed in Excel is the management of lists such as telephone numbers 

and personnel data. In comparison, Access stores data in tables that look much the same as 

worksheets but are designed for complex querying in relation to data stored in other tables and 

locations, and even in fields in other tables. 

 

So, while both programs work well for managing data, each one has clear advantages 

depending on the type of data you are managing and what you want to do with it. 

 

The key to your decision: Is the data relational or not? 

 

If you can store your data logically in a single table or worksheet, then do it. By logically, I mean 

that the data in each column is directly related and need only reside in a single, flat table in 

either Access or Excel. It should reside in and be updated in the same view. Data of this kind, 

contained in a single page or sheet (not multiple) is called flat or non-relational data. The 

personnel example above is a case in point. You would not store an employee's last name in a 

table other than the one that stores the employee's first name. 

 

"The most common task in Excel is the management of lists. If you can store your data logically 

in a single worksheet or table, then do it." 

 
However, if your data needs to be stored in more than one table, then you need a relational 

database. Each table is basically a description of a type of data (such as orders for a customer). 

If you require a relational database, you've identified a one-to-many relationship in your data. 

For example, if you have a customer order database, one table will contain customer names 

and another will contain their orders. And a single customer can have many orders. 

Additionally, you might want to have another table for order details since each order can have 

multiple line items. Relational data is best stored in Access. 

 

Do you notice this direct correlation between the size of your data and the challenge you have 

in organizing it effectively? The more data you have, the more likely you are to store it in 
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multiple tables in Access. To help manage your data and keep it accurate, Access and Excel 

provide you with unique identifiers. In Access, a primary key (an icon in the shape of a key 

visible in Design view of your table) uniquely identifies each record. In Excel, each row is 

numbered and each column is denoted by a letter, so each cell or range of cells has a reference 

such as B5. In life, you have a social security number. It's the best unique identifier you have. 

 

"In Access, you have a primary key. In Excel, you have a cell reference. In life, you have a social 

security number. It's the best unique identifier you have." 

 
Ever noticed how, when at the doctor's office or calling an insurance company, you're asked for 

your social security number as well as your name? Last name and even full name are often not 

unique. Unique identifiers are almost always numeric. They preserve the integrity of your data 

and allow no duplicate records or data in cells that you don't recognize (called Null values). 

Numeric identifiers also provide the quickest way to retrieve data when searching or sorting. 

 

When to use Access 

Use Access when you: 

 

 Require a relational database (multiple tables) to store your data.  

 May need to add more tables in the future to an originally flat or non-relational data set.  

  

For example, if you want to keep track of customer information such as first and last names, 

addresses, and telephone numbers, but that information may grow to include actions by 

customers such as orders, then consider starting your data project in Access. 

 

 Have a very large amount of data (thousands of entries).  

 

For example, if you work in a large company and are required to store personnel 

information, then use Access. 

 

 Have data that is mostly of the long text string type (not numbers or defined as numbers).  

 Rely on multiple external databases to derive and analyze the data you need.  

 

For example, if you need to import or export data regularly from Access databases, it may 

make the most sense to work in Access to maximize compatibility. 

 

 Need to maintain constant connectivity to a large external database such as one built with 

Microsoft SQL Server.  

 Want to run complex queries.  

 

For example, if you work in a large company that takes customer orders, you might have to 

look up customer names stored in a SQL Server database while taking new customer orders 

in Access. You can maintain a connection to the SQL Server database from within the Table 
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view in Access. When you add or look up a customer name, you are working against the SQL 

Server database, but the new order details you just took are stored locally in Access tables. 

 

 Have many people working in the database and want robust options to expose that data 

for updating.  

 

For example, Access offers data access pages for the more technical user and forms if you 

want to be more user friendly. 

 

When to use Excel 

 

Use Excel when you: 

 

 Require a flat or non-relational view of your data (you do not need a relational database 

with multiple tables).  

 

This is especially true if that data is mostly numeric—for example, if you want to maintain a 

financial budget for a given year. 

 Want to run primarily calculations and statistical comparisons on your data — for example, 

if you want to show a cost/benefit analysis in your company's budget.  

 Know your dataset is manageable in size (no more than 15,000 rows).  
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1. Create the following worksheet in Excel. 

 

RNO NAME COMPUTER MATHS SCIENCE TOTAL 

531 Mike 57 67 86  

532 Jones 43 78 89  

533 Chris 23 68 57  

534 Shin 56 89 78  

535 York 54 78 67  

 

(a) Fill the TOTAL column. 

(b) Filter the candidate whose ROLLNO > 532 

(c) Filter the candidate whose MATHS > 70. 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through G3. Highlight and make them in Bold 

with center alignment.  

3. Fill the table with given data for name, computer, maths and science marks. 

 

 
 

To Fill the TOTAL column: 

 

4. Select cell G3, click on function button . Insert function dialog box appears.  
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Sum function is already selected, click on OK button.  

5. Function Arguments dialog box appears: 

 

 
 

6. Select the range D4:F4 in Number1 textbox and click on OK button. Now formula bar will 

contain a new formula in the G4 cell =SUM (D4:F4) 

7. Now click on  button to get the sum. 
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8. Select the G4 cell. Take the cursor to the bottom-right corner to get a plus symbol. Hold 

it and drag down to autofill the rest of the cells in the column. 

 

 
 

To filter the candidates whose ROLLNO > 532 

 

9. Select the complete table. Go to Data menu-> Filter-> AutoFilter. After applying 

AutoFilter to the table, it looks like this: 

 

 
 

10. Select the drop-down menu from RNO column and click (Custom…) 
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Custom AutoFilter dialog box appears.  

 

 
 

11. In RNO select is greater than from left box and 532 from right box. Click on OK button.  

12. The following output is generated that show rows where RNO is greater than 532. 

 

 
 



 

Al-Qurmoshi Institute of Business Management | Computer Practicals - LAB 38 

 

To filter the candidate whose MATHS > 70 

 

13. Now remove filters by deselecting Data->Filter->AutoFilter. 

14. Again select the complete table. Go to Data->Filter->AutoFilter. 

15. In the similar manner Filter the rows where Maths is greater than 70 

 

 

 
2. The following are the marks obtained by the students of MBA in three Subjects: 

 

Roll No Name ME IT HRM 

1014 Joe 86 95 88 

1015 Clark 45 37 68 

1012 Nice 75 87 57 

1011 Green 65 74 85 

1013 Nick 78 67 46 

 

a) Sort the data by roll no 

b) Using Conditional Formatting list out students who scored More than 65 in IT 

c) Using Conditional Formatting list out students who scored Between 60 and 80 in 

HRM. 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through F3. Highlight and make them in Bold 

with center alignment. 

3. Fill the table with given data for name, ME, IT and HRM. 

 

To Sort data by Roll No 

 

4. Select the entire table. Go to Data->Sort… A new Sort dialog box appears. Roll No in 
Ascending order is already selected. 
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5. Click OK to get the data sorted in Ascending order of Roll No. 

 

 
 

To use Conditional Formatting to list out students who scored More than 65 in IT: 

 

6. Select the range E4 to E8 for IT subject.  

7. Go to Format-> Conditional Formatting; Conditional Formatting Dialog box appears. 

8. In Condition1, Select Call Value Is in the First combo box, Greater than in Second combo 

box and type 65 in third combo box. 
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9. Now Click Format… button down, Format Cells dialog box appears; select formatting of 

your choice. 

 

 
10. Click OK to apply formatting. Click OK to apply condition. 
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To Use Conditional Formatting to list out students who scored Between 60 and 80 in HRM. 

 

11. Select the range F4 to F8 for HRM subject.  

12. Go to Format-> Conditional Formatting; Conditional Formatting Dialog box appears. 

13. In Condition1, Select Call Value Is in the First combo box, select Between in Second 

combo box, type 60 in third combo box and type 80 in the Fourth combo box. 

14. Now Click Format… button down, Format Cells dialog box appears; select formatting of 
your choice.  

 
 

15. Click OK to apply formatting. Click OK to apply condition. 
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3. Calculate HRA, DA, IT, PF, PF, Gross Salary, Net Salary from given data in a worksheet: 

 

ENO ENAME Basic Pay HRA DA Gross Pay IT PF Net Pay 

E101 Harry 10000       

E102 Bright 18000       

E103 Sunny 20000       

E104 John 10000       

E105 Mink 19000       

 

Where 

House Rental Allowance HRA  is  15%  of  Basic 

Depreciation Allowance DA  is  13%  of  Basic 

Income Tax   IT is 5% of Basic 

Provident Fund  PF  is  9%  of  Basic 

 

Gross Pay   =  Basic Pay + HRA + DA 

Net Pay  =  Gross Pay - IT – PF 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through J3. Highlight and make them in Bold 

with center alignment.  

3. Fill the table with given data for ENO, ENAME, and Basic Pay. 
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4. Select cell E4; type =15*D4/100 and hit enter button. 15% of Basic is calculated as HRA 

in the E4 cell. 

5. Again select E4 cell; take cursor to the bottom right corner of the cell till it becomes + 

hold and drag down to copy the formula to the rest of the rows. 

6. Select cell F4; type =13*D4/100 and hit enter button. 13% of Basic is calculated as DA in 

the F4 cell. 

7. Again select F4 cell; take cursor to the bottom right corner of the cell till it becomes + 

hold and drag down to copy the formula to the rest of the rows. 

8. Select cell G4; type =D4+E4+F4 and hit enter button. Sum of Basic, HRA and DA is 

calculated as Gross Pay in the G4 cell. 

9. Again select G4 cell; take cursor to the bottom right corner of the cell till it becomes + 

hold and drag down to copy the formula to the rest of the rows. 

10. Select cell H4; type =5*D4/100 and hit enter button. 5% of Basic is calculated as IT in the 

H4 cell. 

11. Again select H4 cell; take cursor to the bottom right corner of the cell till it becomes + 

hold and drag down to copy the formula to the rest of the rows. 

12. Select cell I4; type =9*D4/100 and hit enter button. 9% of Basic is calculated as PF in the 

I4 cell. 

13. Again select I4 cell; take cursor to the bottom right corner of the cell till it becomes + 

hold and drag down to copy the formula to the rest of the rows. 

14. Now the final report after calculation is like this: 
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4. Prepare Pivot Table. 

  

 

 

 

 

 

 

 

 
1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through D3. Highlight and make them in Bold 

with center alignment. 

3. Fill the table with given data for Employee Name, Department, and Salary Rs. 

 

 
 

4. Select the complete table go to Data menu, select "PivotTable and PivotChart Report". 

 

 

Employee Name Department Salary Rs. 

A Sales 4000 

B Accounts 5000 

C Marketing 6000 

D Sales 4000 

E Accounts 8000 

F Marketing 4000 
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5. A PivotTable wizard should appear.  

 

 
 

6. Make sure that the "Microsoft Excel list or database" and "PivotTable" options are 

chosen. Click on the Next button. 

 

 
 

7. Select the range of data for the pivot table and click on the Next button. 
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8. Select the position to create the new pivot table. It will automatically default to the cell 

that was highlighted when you started this process. Click on the Layout button. 

9. Now drag the fields that you want to appear in the Page, Row, Column, and Data 

sections of the pivot table. In this example, we've dragged the Department field to the 

Row section and the Salary Rs. to the Data section. 

10. Click on the OK button to continue. 
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11. Now click on the Finish button. 

 
 

12. Your pivot table should now appear on new sheet. What this pivot table displays is the 

total Salary for each Department. 
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5. From the table given below, reduce the total expenditure to Rs.16000 by reducing 

sales department’s Expenditure by applying Goal seek. 

  

Department Expenditure Rs. 

Production 4000 

Sales 6000 

Marketing 3000 

Finance 5000 

Total Expenditure 18000 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through C3. Highlight and make them in Bold 

with center alignment.  

3. Fill the table with given data for Department and Expenditure Rs. 

 

 
 

4. Calculate the total expenditure by adding up all departments expenditure in cell C8 

=Sum(C3:C6) 

5. Select cell C8, Go to Tools-> Goal Seek… 
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6. Set Cell already contains C8.  

7. Type 16000 in To Value box as we’ve to set Total Expenditure (C8) to 16000 

8. By Changing Cell Sales Expenditure ie C4 
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9. Click OK 

10. Goal Seek status is displayed. Observe Sales Expenditure ie C4 is adjusted to 4000 to get 

Total expenditure 16000 

 

 

 
6. Create an excel worksheet to demonstrate absolute and relative cell referencing using 

the following table: 

  

Item Quantity Price Total 

Chair 4 Rs. 600  

Desk 4 Rs. 1700  

Lamp 3 Rs. 500  

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through E3. Highlight and make them in Bold 

with center alignment.  

3. Fill the table with given data for Item, Quantity, and Price. 
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4. To prefix the price with Rs. Tag, Right click on the price column, go to Format Cells…  
5. Select Currency from Category: list box. On the right side select Rs. from combo box in 

Symbol: 

(if you don’t see Rs. in the box then change your Regional settings in the Control Panel) 
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6. In the Category: List box, select Custom and type currency format as Rs.#,##0 
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7. Click OK. 

  
 

Relative Reference 

 

8. Select cell E4 and calculate the amount by multiplying quantity and price i.e.,  

=C4*D4 

 

 
 

9. Drag down the result in the E4 cell to the rest of the rows.  

 

 
 

10. Here in E5 the formula is copied as  

=C5*D5 

11. Similarly E6 contains the formula  

=C6*D6 

 

This is called relative referencing where the row and column references change 

when you copy the formula to another cell because the references are actually 

offsets from the current row and column. 
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Absolute Reference 

 

12. Assume that the Sales tax is applied on the items purchased. Then we need to calculate 

a fixed sales tax on every item purchased. 

13. For this we use absolute referencing which allows us to calculate sales tax in the right 

way. 

14. Assume that the Sales tax is 10% 

 

 
 

15. Sales Tax column is calculated as   

Quantity * Price * Sales Tax 

 

16. For this select cell E4, type 

=C4*D4*$C$9 

 
 

17. Drag down the result to copy the formula 
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18. Observe you’ll in cell E5 formula is 

=C5*D5*$C$9 

 

19. And cell E6 contains formula 

=C6*D6*$C$9 

 

Here the use of $ before row and column name makes it absolute i.e., the row 

and column references do not change when you copy the formula because the 

reference is to an actual cell address. This is called absolute referencing. 

 

20. Now calculate Total column which is calculated as   

Quantity * Price + Sales Tax 

21. Select cell F4, type formula 

=C4*D4+E4 

 

 
 

Drag down the result in the F4 cell to the rest of the rows. This is relative 

referencing. Calculation of Sales Tax column is done using the absolute reference 

method. 
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7. Create an excel worksheet to demonstrate the use of mixed referencing with 

multiplication table. 

 
1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through L3. Highlight and make them in Bold.  

3. Similarly, select cell B4, type row headings through B13. Highlight & make them in Bold. 

 

 
 

Mixed References 

 

4. To create a multiplication table we make use of mixed references. The formulas in the 

table calculate the multiplication for number 1 to 10. The formula in cell C4 is 

=$B4*C$3 
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5. Notice that both cell references are mixed. The reference to cell B4 uses an absolute 

reference for the column ($B), and the reference to cell C3 uses an absolute reference 

for the row ($3).  

6. As a result, this formula from cell C4 can be copied down and across, and the 

calculations will be correct. 

 

 
 

7. For example, the formula in cell F7 is 

=$B7*F$3 

 

If C4 used either absolute or relative references, copying the formula would 

produce incorrect results. 

Formula where either the row or column reference is relative, and the other is 

absolute is called mixed referencing. 
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8. Create an excel worksheet with the data as follows: 

 

AMOUNT IN CRORES 

YEAR  SALES  EXPENSE 

1997  250 100 

1998  300 150 

1999  350 200 

2000  430 250 

2001  500  300 

2002  550 350 

2003  600 400 

2004  650 450 

 

Use the above table to create Column Chart 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through D3. Highlight and make them in Bold.  

3. Fill the table with given data for Year, Sales, and Expense. 

 

 
 

4. Select the cells C3 to D11, go to Insert menu select Chart… option 
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5. On the Chart Wizard Step 1 of 4, in the Chart Type list box, click Column. In the Chart 

Sub-type list, click the first chart: Clustered Column 

 

 
 

6. Click Next  
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7. In the Chart Wizard Step 2 of 4, make sure the Columns radio button is selected.  

8. In the Chart Wizard Step 2 of 4, select Series tab, in the Category (X) axis labels, select 

column from B4:B11 by clicking on the  button. 

 

 
 

9. Click Next  

10. In the Chart Wizard Step 3 of 4, Type Yearly Sales & Expenses as Chart Title, Year in 

Category (X) axis and Sales & Expenses in Category (Y) axis. Click Next 
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11. In step 4 of 4, click Finish 
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9. Create an excel worksheet with the data as follows for Life Expectancy at birth: 

 

COUNTRY  CODE TOTAL  MALE FEMALE 

Algeria AG 69.24 68.97 70.46 

Netherlands NL 78.15 75.28 81.17 

Venezuela VE 72.95 69.97 76.16 

Australia AS 80.14 77.22 83.23 

Yemen YM 59.98 58.17 61.88 

Switzerland WZ 38.11 36.86 39.4 

 

Use the above table to create Bar Chart 

 
1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through D3. Highlight and make them in Bold.  

3. Fill the table with given data for Country, Code, Total, Male and Female. 

 

 
 

4. Select the cells D3 to F9, go to Insert menu select Chart… option 
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5. On the Chart Wizard Step 1 of 4, in the Chart Type list box, click Bar. In the Chart Sub-

type list, click the chart on 1st column, 2nd row: Clustered Bar With 3-D Visual Effect 

 

6. Click Next  

7. In the Chart Wizard Step 2 of 4, make sure the Columns radio button is selected. Click 

Next  
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8. In the Chart Wizard Step 3 of 4, type Life Expectancy at Birth in Chart Title, Country in 

Category (X) axis and Age in Category (Z) axis. click Next  
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9. In step 4 of 4, click Finish 
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10. Create an excel worksheet with the data as follows: 

 

Age Consumption 

0-5 5% 

6-12 15% 

13-20 25% 

21-35 30 % 

36-60 15% 

above 60 10% 

Use the above table to create Column Chart 

 
1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through C3. Highlight and make them in Bold.  

3. Fill the table with given data for Age, and Consumption. 

 

 
 

4. Select the complete table, go to Insert menu select Chart… option 
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5. In the Chart Wizard Step 1 of 4, in the Chart Type list box, click Pie. In the Chart Sub-type 

list, click the first. Click Next  

 
6. In the Chart Wizard Step 2 of 4, make sure the Columns radio button is selected. Click 

Next  

7. In the Chart Wizard Step 3 of 4, click Next  

8. In step 4 of 4, click Finish 
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11. Create an excel worksheet to demonstrate macros. 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through J3. Highlight and make them in Bold 

with center alignment.  

3. Fill the table with sample data for RNO, MOB, ME AFM, MM, SFM, BL, IT and calculate 

the Total. 

 

 
 

4. From the Tools menu, point to Macro and click on Record New Macro.  
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5. From the Record Macro dialog box displayed, enter a name for the macro in the Macro 

name: text box as Toppers and assign a shortcut key t (ctrl+t). 

 
6. The default description is displayed in the Description: text box, and contains the date 

and user name. If required, change it. 

7. To begin recording, click OK. 

8. We will filter top 10 students of the class. For this select header rows, from RNO to TOT 

then go to Data->Filter-> AutoFilter 

 

 
 

9. All the headers are now having small drop down arrows. Click on arrow of TOT field, 

select Top 10 
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10. TOP 10 AutoFilter dialog box appears, make sure 10 is selected in the second box, click 

OK. 

 

 
 

11. You’ll get 10 students names who got highest marks in the class. 
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12. To stop recording, either click the stop button from small menu displayed on the left 

side of the window or from the Tools menu, point to Macro and click on Stop 

Recording.  

 

 
 

13. Now we’ll create a macro that will remove autoFilter and display all content. For this 

again From the Tools menu, point to Macro and click on Record New Macro 
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14. From the Record Macro dialog box displayed, enter a name for the macro in the Macro 

name: text box as Stoppers and assign a shortcut key p (ctrl+p). 

 

 
 

15. To begin recording, click OK. 

16. We will stop filtering top 10 students of the class. For this go to Data->Filter-> AutoFilter 

which will deselect the AutoFilter option. 
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17. To stop recording, from the Tools menu, point to Macro and click on Stop Recording.  

 

 
 

18. To create a button and assign an Excel macro to it 

 

19. If the Forms toolbar is not displayed, right click on any toolbar that is visible and from 

the pop-up menu that is displayed select Forms.  

20. To create a button, click the Button icon on the Forms toolbar. 
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21. Then, click and drag the mouse to the intended button size.  

22. Rename the button with "Top 10" 

23. Right-click on the button corner and select "Assign Macro…"  

 

 
 

24. The Assign Macro dialog box will be displayed. 
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25. Select the Toppers Macro and Click on the OK button.  

26. Similarly create another button and assign Stoppers macro to it and click OK button 
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27. As a result you’ll have two buttons that displays top 10 students and another resets the 

filter. 

 

 
 

To run a macro using the Tools Macro command 

 From the Tools menu, point to Macro and click on Macros.  



 

Al-Qurmoshi Institute of Business Management | Computer Practicals - LAB 78 

 

 From the Macro dialog box displayed, click on the name of the macro you wish to run in 

the Macro name: list box.  

 Click the Run button. 

 

To run a macro using the assigned shortcut key 

 Press Ctrl+?, with ? is the letter which you assigned. 

 

To delete a button 

 Click on button and press the Delete key. 
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12. Create the following worksheet in Excel. 

 

RNO MOB ME AFM MM SFM BL IT TOT AVG GRADE MAX MIN 

1              

2              

3              

4              

5              

 

a) Fill the TOTAL column. 

b) Fill the AVERAGE column. 

c) Grade as 

 

If average >=70,    Distinction 

If average >=60 and average <70,  1st class 

If average >=50 and average <60,  2nd class 

If average >=40 and average <50,  3rd class 

Else      fail. 

d) Min 

e) Max 

 

 
1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Select cell B3, type the column headings through N3. Highlight and make them in Bold 

with center alignment. 

3. Fill the table with sample data for marks of MOB, ME, AFM, MM, SFM, BL, and IT. 

 

 
 

4. Select cell J4, click on  button on formula bar; select Sum from Insert Function dialog 

box. Select cells C4 through I4, select OK the formula will look like  

 

=SUM(C4,D4,E4,F4,G4,H4,I4)  or  =SUM(C4:I4) 
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5. Drag down the result to copy function on to other rows 

6. Similarly select cell K4 and calculate average as 

 

=AVERAGE (C4,D4,E4,F4,G4,H4,I4) or  =AVERAGE(C4:I4)  or  = J4/7 

 

 
 

7. Drag down the result to copy function on to other rows 

8. To calculate Grade, we will make use of formula in cell L4 as follows 

 

= IF(AND(K4>=70),   "Distinction",  

IF(AND(K4>=60,K4<70), "First",  

IF(AND(K4>=50,K4<60),  "Second",  

IF(AND(K4>=40,K4<50),  "Third",  

"Fail" 

)))) 
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9. Drag down the result to copy formula on to other rows 

10. Similarly select cell M4 and calculate maximum marks as 

 

=MAX (C4,D4,E4,F4,G4,H4,I4)  or =MAX(C4:I4) 

 

 
 

11. Drag down the result to copy function on to other rows 

12. Similarly select cell N4 and calculate minimum marks as 

 

=MIN (C4,D4,E4,F4,G4,H4,I4)  or =MIN(C4:I4) 

 

 
 

13. Drag down the result to copy function on to other rows 
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14. To add title to it, select cells B1 through N1 and click on Merge and Center  button 

from formatting toolbar, Type PROGRESS REPORT, bold the font and increase the font 

size, the final report can be saved to disk or printed. 

 

 

 
13. Calculate the mean, median, and mode from the following data of marks obtained by 

10 students. Also demonstrate how to transpose rows into columns. 

 

S. No.: 1 2 3 4 5 6 7 8 9 10 

Marks: 15 32 29 17 32 32 25 29 20 35 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Design the table with given data for SNo and Marks in horizontal format. 

 

 
 

Move data between rows and columns 

 

3. COPY the table data by selecting the table. 
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4. Before you paste the copied data, right-click your destination cells and then click Paste 

Special.  

 

 
 

5. In the Paste Special dialog box, select Transpose, and then click OK.  

You'll find the Transpose check box in the lower-right corner of the dialog box:  
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Excel pastes the data in vertical format. 

 
 

6. Design the table in the following way: 
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7. Calculate Mean in cell C15 as 

=AVERAGE(C4:C13) 

 

 
 

8. Calculate Median in cell C16 as 

=MEDIAN(C4:C13) 
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9. Calculate Mode in cell C17 as 

=MODE(C4:C13) 
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14. Taj wants to start a business. He estimated that it will cost him Rs. 3,75, 000 to start 

the business and expects to earn a net income of Rs. 75,000, Rs. 1,02,500, Rs. 90,000, 

Rs. 62,500, Rs. 1,20,000, and Rs. 1,22,500 respectively, in the first six months.  

Calculate the Internal Rate of Return (IRR) 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Design the worksheet as follows: 

 

 
 

Function Internal Rate of Return,  

IRR (values, guess) 

 

3. Click cell D12 and type =IRR( 

4. Select cells D4:D10 and, on the Formula Bar, click the Enter button  
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5. Right-Click on Cell D12, go to Format cell and select Percentage in Category list box. 

 

 
 

6. In cell D11, type 12 and click cell D12 

7. In the Formula Bar, change the function to =IRR(D4:D10, D11) and press Enter (you 

shouldn't need any significant difference unless you change the range of cells such as 

D4:D8) 

8. Save the workbook 



 

Al-Qurmoshi Institute of Business Management | Computer Practicals - LAB 89 
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15. A motorcar is purchased for Rs. 8, 12, 500 that has a life of 5 years and salvage value 

of Rs. 1, 25, 000. Calculate depreciation by straight line method. (Use SLN financial 

function). 

 
 

1. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

2. Design the worksheet as follows: 

 

 
 

3. Click cell C7 and, on the main menu, click Insert -> Function...  

4. In the Paste Function dialog box, in the Function Category list, click Financial. In the 

Function Name list, double-click SLN. 

 

 
 

5. Move the SLN window so you can see the values on the worksheet. 
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6. Click the box to the right of Cost and, on the worksheet, click cell C4  

7. In the SLN window, click the box to the right of Salvage and, on the worksheet, click cell 

C5  

8. In the SLN window, click the box to the right of Life and, on the worksheet, click cell C6  

 

 
 

9. Click OK  
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16. Tenley Investments has got investments of Rs. 7, 25, 000 and has a lifetime of 10 

years. The salvage value of the investment is Rs. 67, 500. Using DDB function; calculate 

depreciation over the life of the investment for first two months. 

 
 

10. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Excel 2003. 

11. This will start a new workbook then fill up Sheet as follows: 

 

 
 

12. Click cell C8 and, on the main menu, click Insert -> Function...  

13. In the Paste Function dialog box, in the Function Category list, click Financial. In the 

Function Name list, double-click DDB. 
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14. Move the DDB window so you can see the values on the worksheet 

 
 

15. In the DDB window, Click the box to the right of Cost and, on the worksheet, click cell C4  

16. Click the box to the right of Salvage and, on the worksheet, click cell C5  

17. In the DDB window, click the box to the right of Life and, on the worksheet, click cell C6  

18. Click the box to the right of Period and, on the worksheet, click cell C7  

19. In the DDB window, click the box to the right of Factor and type 2 (because double-

declining method always takes 2 as factor even if omitted). Click OK 
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Microsoft  
Access 
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17. Create a database called “dbStudent” and create three tables with names tblStudent, 

tblCourse, and tblStudentCourse respectively with the following details: 

 
 

Table: tblCourse 

Field Name Data Type 

  CourseID Number 

     CourseTitle Text 

     CreditHour Number 

     Description Memo 

Table: tblStudent 

Field Name Data Type 

  StudentID Number 

     SName Text 

     GPA Number 
 

 

Table: tblStudentCourse 

Field Name Data Type 

 StudentID Number 

     CourseID Number 

     DateTaken Date/Time 

     Seat Text 

 
 

1. First, you need to create a directory in My Document with name "database" 

2. Click MS Access icon from Start menu or on your desktop. 

 

 
 

3. Select Blank database from right panel. 
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4. Find the directory you just created and type the database name, say “dbStudent” in this 

case, and then click “Create” button. 
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To create tblCourse in Design View: 

5. Double-Click on Create table in Design view  

 

 
6. Design the table with the given FieldName and DataType. 
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7. Right-click on the CourseID. Set it as Primary Key. 
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8. Save the table with tblCourse name. 

 
 

9. Close the window. Observe tblCourse table is created in dbStudent database.  

 

10. Double-click on the tblCourse to fill the table with sample data. 
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To create tblStudent using Wizard: 

 

11. Double-Click on Create table by using wizard.  

 

 
 

12. TableWizard window appears. Make sure Business option is selected. 

13. Choose Students from Sample Tables list box. 
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14. Select StudentID, FirstName and PhoneNumber from Sample Fileds list box using  

button. Renam FirstName to SName and PhoneNumber to GPA 

 

 
 

15. Give table name as "tblStudent" and make sure "Yes, set a primary key for me." option 

is selected. 
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16. In the next step, Click on Next button. 

 

 
 

17. In the next step, "Enter data directly into the table." Select Finish. 

 



 

Al-Qurmoshi Institute of Business Management | Computer Practicals - LAB 104 

 

 
 

18. Start entering sample data 

 

 
 

To create tblStudentCourse by entering data: 

 

19. Double-click on the Create table by entering data. 
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20. A new window appears; right-click on the fields and select Rename Column option to 

rename the fields. 

 

 

21. Rename all the fields as given. Make sure you are not filling the table with any data. 
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22. Save it with tblStudentCourse name. 

 

23. Right-click on tblStudentCourse and select design view. 
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24. Change the data types as given in the question. In data and time data type. Select 

Format as Medium Date. 

 

 

 

25. Close above window, you’ll again be seeing window shown below. 
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26. Double-click on the tblStudentCourse and start entering sample data 
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Three tables are created with three different methods in Access. 
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18. Create a database dbEmployee and create tables tblEmployee and tblDepartment.  

 

 Build Relationships between tblEmployee and tblDepartment.  

 Create a report on tblEmployee. 

 

Table: tblEmployee 

Field Name Data Type 

 EmployeeID Number 

     EName Text 

     Designation Text 

     Salary Number 

     DepartmentID Number 
 

 

Table: tblDepartment 

Field Name Data Type 

 DepartmentID Number 

     DepartmentName Text 

     Description Memo 

 
1. First, you need to create a directory in My Document with name "database" 

2. Click MS Access icon from Start menu or on your desktop. 

 

 
 

3. Select Blank database from right panel. 
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4. Find the directory you just created and type the database name, say “dbStudent” in this 

case, and then click “Create” button. 
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To create tblEmployee in Design View: 

5. Double-Click on Create table in Design view  

 

6. Design the table with the given FieldName and DataType. 

7. Right-click on the EmployeeID. Set it as Primary Key. 

8. Save the table with tblEmployee name. 
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9. Close the window. Observe tblEmployee table is created in dbEmployee database.  

 

 
 

10. Double-click on the tblEmployee to fill the table with sample data. 
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To create tblDepartment in using Wizard: 

11. Double-Click on Create table in Design view  

 
12. Design the table with the given FieldName and DataType for second table. 

13. Right-click on the DepartmentID. Set it as Primary Key. 
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14. Save the table with tblDepartment name. 

 

 

15. Close the window. Observe tblDepartment table is created in dbEmployee database.  
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16. Double-click on the tblDepartment to fill the table with sample data. 

 

To Build Relationships between tblEmployee and tblDepartment: 

 

We can establish relationships between two or more tables by associating common fields. In 

the dbEmployee database, the DepartmentID is a common filed in both tables. It is the primary 

filed in tblDepartment table. To establish relationships between the DepartmentID fields in the 

tblEmployee and tblDepartment, proceed as follows: 

 

17. Use the Tools->Relationships menu option to display the Show Table dialog box. Once 

displayed,  

 

a. select tblDepartment and Click Add 

b. select tblEmployee and Click Add 
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18. Close the Show Table dialog box. 

19. Now drag the table boxes so they are positioned approximately as shown in the 

following illustration. 

20. Establish the join lines (relationships) by selecting DepartmentID in the tblEmployee box 

and draggin to tblDepartment box and release the mouse button. 

 

 
 

21. Edit Relationships dialog box appears. Make sure that DepartmentID is selected in both 

the boxes in Edit Relatiobsips dialog box and click Create button. 
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22. Verify that your join lines resemble those shown in the illustration below. The Close and 

click Yes to save the relationships. 

 

 
To Create a report on tblEmployee: 

 

23. In the Database window, click Reports under Objects. 
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24. Click the New button on the Database window toolbar. 

 

In the New Report dialog box you can see six ways to create reports in Microsoft Access: 

 

Design View Begins with blank page. You lay out the report the way you want using 

the design tools in the toolbox. 

Report Wizard Choice of fields, sort criteria, & report layout used. Creates tabular or 

columnar report. 

Columnar AutoReport One or more records displayed vertically. Selected from a single 

table or query. Each field appears on a separate line with a label to its 

left. 
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Tabular AutoReport Rows and columns grouped by field values. Selected from a single table 

or query. The fields in each record appear on one line, & the labels print 

once at the top of each page. 

Chart Wizard Leads you through creation of a report containing a chart and associated 

data. 

Label Wizard Helps you create mailing labels from data. 

 
 If you clicked Report Wizard, Chart Wizard, or Label Wizard then you can follow the 

directions in the wizard dialog boxes, 

 If you click AutoReport: Tabular or AutoReport: Columnar, MS Access automatically creates 

your report. 

 If the resulting report doesn’t look the way you want, you can change it in Design View. 

 

25. Select the AutoReport: Tabular and select the table tblEmployee from box given below. 

Remember AutoReport displays all the fields & records in the underlying table or query. 

 

 

26. Click OK. tblEmployee report is generated as follows: 
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19. Create Employee salary table and give 5 records.  

 

 The salary field cannot accept > 40,000 

 Sort Salary field 

 Write a query to display the records for salary > 20,000 

 

Table: tblEmp 

Field Name Data type 

 EmpNo Number 

     EmpName Text 

     Designation Text 

     

Department 

Text 

     Salary Number 

 
 

1. First, you need to create a directory in My Document with name "database" 

2. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Access 2003. 
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3. Select Blank database from right panel. 

 

4. Find the directory you just created and type the database name, say “dbEmployee” in 

this case, and then click “Create” button. 
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Create tblEmp in Design View: 

5. Double-Click on Create table in Design view  

 

6. Design the table with the given FieldName and DataType. 

7. Right-click on the EmpNo. Set it as Primary Key. 

8. Save the table with tblEmp name. 
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9. Observe that the dbEmployee database contains tblEmp table in the database window. 

 

Salary field cannot accept > 40,000 

To restrict fields from accepting a range of values, we can give validations rules in Design View. 

 

10. To restrict Salary field not to accept Salaray more than 40000, click Salary field of tblEmp 
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table, in field propertied, locate Validation Rule and type <= 40000. 

 

11. You can fill the table with sample data. If you attempt to give any number greater than 

40000, it’ll show violation error. 

 

Sort Salary field 

12. To sort Salary field, Select the field content, go to Sort-> Sort Ascending (to sort in 

increasing order of Salary) or Sort Descending. In this example we select Sort Ascending 
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Sorted result is displayed in the illustration below: 

 

 
 

Write a query to display the records for salary > 20,000 

 

13. In the Database window, select Queries under Objects: 
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14. Double click on Create Query in Design View 

Select Query window along with Show Table dialog box appears. 

15. Select table tblEmp and click on Add button. 

16. Close the Show Table dialog box 

 

 
 

17. In the Select Query window, drag and drop fields of tblEmp table in the Filed row. 

18. In the Criteria row, select the cell that intersects with Salary. Type >20000, since our 

query is to display all the records that contain salary >20000, 
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19. Save and name the query as tblEmp Query1 

20. To run the query, double-click on the tblEmp Query1 

 

The result will be displayed on the screen. 



 

Al-Qurmoshi Institute of Business Management | Computer Practicals - LAB 130 
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20. Create a database dbBusiness and a table tblBill. 

 

Table: tblBill 

Field Name Data type 

 BillNo AutoNumber 

     ItemNo Number 

     ItemName Text 

     ItemPrice Number 

     Quantity Number 

     Total Number 

 

 Create Query to calculate Total 

 Create a Form using tblBill table. 

 Create Macro to Open Form to Fill data in Table. 

 
 

1. First, you need to create a directory in My Document with name "database" 

2. Click on the Start button, point to Programs, followed by Microsoft Office and click on 

Microsoft Office Access 2003. 
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3. Select Blank database from right panel. 

 

4. Find the directory you just created and type the database name, say “dbBusiness” in this 

case, and then click “Create” button. 
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Create tblBill in Design View: 

5. Double-Click on Create table in Design view  

 

6. Design the table with the given FieldName and DataType. 

7. Right-click on the BillNo. Set it as Primary Key. 

8. Save the table with tblBill name. 
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9. Observe that the dbBusiness database contains tblBill table in the database window. 

 

Query 

10. Create a query that calculates Total = ItemPrice * Quantity. 

11. To do this, in the Database window Click Queries from Objects panel. 
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12. Click on New button. New Query dialog box appears.  

13. Select Simple Query Wizard. Click OK 

 

14. As we need to calculate query on Total, select single field Total and click on Next button. 
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15. Click Next. 

 

16. Click Next. 
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17. Click on Finish button. Close the select query window that appears. 

18. Observe that the dbBusiness database contains tblBill Query in the database window. 

 

19. Right-click on the tblBill Query and select Design View 

20. Go to Query menu and select Update Query.  
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You can observe Sort and Show options are replaced with Update to option. 

 

21. Right-click on the first cell next to Update to: and select Build. 
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Expression Builder window appears. 

22. Double click on tables and select tblBill from first list box. 

In the second list box all the fields of tblBill are displayed. 

23. Double click on ItemPrice, entry will be added on the above box as  

[tblBill]![ItemPrice] 

24. Click on * from the buttons given below the box. 

25. Double click on Quantity, entry will be added on the above box as  

[tblBill]![Quantity] next to [tblBill]![ItemPrice] * 

 

26. Click OK and Save it. 
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Form 

27. After creating Table and Query, Create a Form in the simple way as follows: 

28. Select Forms from Database window under Objects. 

 

29. Click on New button. 

30. Select Form Wizard and select tblBill in the box below and click OK. 

 

31. Form wizard opens up, select all fields but the Total field. 
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32. Click Next 

 
33. Click Next 
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34. Name the form as frmBill. 

 
 

35. Click Finish. 

 

Macro 
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36. Select Macros from Database window under Objects. 

 

37. Use the dropdown menu to select your first action - choose "OpenForm".  

38. In the bottom pane, select the form name you wish to open - choose "frmBill" 

39. Select Data Mode as Add 

 

40. Use the dropdown menu to select your second action - choose "GoToRecord".  

41. In the bottom pane, choose the record you want to go to - choose "New".  
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What we're doing here is ensuring that the form doesn't open up a previous record - it 

goes straight to the end and has a blank record ready for you to enter a new record (this 

saves time and unnecessary clicks).  

 

42. Run macro, access will open frmBill for you with New Record. You can fill the records. 

 

43. Click on Next arrow and fill the details. 
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44. After entering details in the similar manner, open table tblBill, you can see the records 

are filled with the data but the Total field is not calculated. 

 

45. To calculate Total quickly run your query tblBill Query1 

46. Access prompts before proceeding, click Yes. 

 

47. Again it prompts say Yes. 

 



 

Al-Qurmoshi Institute of Business Management | Computer Practicals - LAB 146 

 

48. Now open tblBill, you’ll see Total field is filled with data calculated. 
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